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 มีการพูดถึง MCU 8 bit ตัวใหมของทางบริษัท ST มาตั้งแตชวงปลายปที่แลว วาจะมาพรอมทั้งคุณสมบัติอันมากมาย ดวยราคาที่
ยอมเยา (ราคาต้ังแต 1 ดอลลารถึงครึ่งดอลลารสหรัฐที่ MOQ 1kpcs.) จนกระทั่งเมื่อเร็วๆนี้ ถึงไดมีการเปดตัว MCU ตระกูลใหมนี้ภายใต
ช่ือ STM8, ความแตกตางของ MCU จากผูผลิตรายนี้ ที่แตกตางจาก MCU 8 bit ตระกูลอื่นๆที่มีขายอยูในทองตลาดที่ผานมาคือ  
 
1) จะทําการตลาดเฉพาะโรงงานขนาดใหญ ทําใหไมแพรหลายในตลาดสําหรับรายยอย 
2) Tools ในการพัฒนา (Programmer/Debugger) และ Evaluation Board ไมสามารถหาซื้อไดงาย 

3) ไมมีตํารับตําราภาษาไทยไวศึกษา และไมมี web board ไวปรึกษาผูรู เมื่อมีขอสงสัย 
 
 แตดูเหมือนสถานะการณเหลานี้จะเริ่มคลี่คลายขึ้น ในชวงปที่ผานมา เราเริ่มรูจัก MCU จาก ST ในชื่อของ STM32 ซึ่งเปน 
ARM 32bit- Cortex-M3 ตัวแรก เริ่มมีผูผลิต Evaluation Board ในประเทศ ไดทําบอรดพัฒนาออกมา ทั้ง ETT และ INEX รวมทั้ง
สามารถซื้อชุด Programmer/Debugger ที่ช่ือ R-Link หรือซื้อปลีกเฉพาะตัว MCU ไดจากบริษัททั้งสอง 
 แตตัวที่ผมตั้งใจจะพูดถึงในวันนี้คือ MCU 8 bit ตัวใหม ที่ไดขาววาจะมาพรอม ชุดพัฒนาทั้ง Evaluation board, 

Programmer/Debugger ตัวใหมที่ช่ือ ST-Link ประมาณปลายเดือนกรกฏาคมนี้ที่ ETT, ความโดดเดนของ MCU ตัวนี้เมื่อเทียบกับ 
MCU 8 bit ในระดับราคาเดียวกัน แทบจะไมมีคูแขง เพราะมีฟเจอรพ้ืนฐานครบทุกอยาง ทั้ง Flash Memory (เขียนได 10kครั้ง), RAM 

ขนาดใหญ (1k-6kByte), EEPROM ขนาด1k-2kByte (เขียนได 300kครั้ง), การสื่อสารแบบอนุกรมทั้ง UART, I2C, SPI, ซึ่งการ
สื่อสารอนุกรมทุกตัวมี Timer ภายในของตัวเอง ทําใหไมตองไปใช Timer อเนกประสงค, มี Timer อเนกประสงค ขนาด 16 bit ต้ังแต 2-

3 ตัว แลวแตเบอร และมี Timer อเนกประสงค ขนาด 8 bit พรอมพรีสเกลเลอร 8 bit อีก 1 ตัว, มี Advance Timer1 ซึ่งสามารถขับ
มอเตอร 3 เฟสได (ACIM, BLDC), มี High Speed Internal OSC ความละเอียดสูง +/- 2.5% จากโรงงานที่ความถี่สูงสุด 16MHz, 

ในรุน Access Line ตอกับ External OSC ไดสูงสุด 16MHz จะไดความเร็ว 12.8MIPs และในรุน Performance Line ตอกับ 
External OSC ไดสูงสุด 24MHz จะไดความเร็ว 20MIPs, มี ADC ขนาด 10 bit ที่ความเร็ว 300ksample/sec สามารถมัลติเพล็กได
ต้ังแต 4-16ch, มี AWU: Auto Wake up Timer ไวทําการปลุกในโหมดประหยัดพลังงาน รวมทั้งมี Hardware Beeper (ความถี่ 1k, 

2k, 4kHz) ในตัว 

 ที่ผมชอบที่สุดคือมีการจัดวาง Interrupt ที่ดีที่สุดในกลุม MCU ขนาด 8 bit, โดยทั่วไป MCU 8 bit ราคาถูกทั่วไป ไมอนุญาติ
ใหมีการ อินเทอรรัพท ซอน อินเทอรรัพท, ถามีอินเทอรรัพท ตัวที่สองเกิดขึ้น ในขณะที่กําลังทํางานใน ISR: Interrupt Service 

Routine ของอินเทอรรัพท ตัวแรกอยู อินเทอรรัพทแฟลกของตัวที่สองนั้นจะถูก pending หรือคางไวกอน จนกวาจะทําโปรแกรม ISR 

ของอินเทอรรัพทตัวแรกเสร็จ แตของ STM8 สามารถทําอินเทอรรัพท ซอน อินเทอรรัพท ได ถามีการอนุญาติ ตามรูปที่ 1. (STM8 จะมี 
Interrupt Vector ซึ่งเปน Hardware Interrupt เหมือนใน MCS-51 แตมีการใช NVIC: Nested Vector Interrupt Control ซึ่งเปน
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จัดกลุม Hardware Interrupt ใหมาอยูในกลุม Software Interrupt เดียวกันไดถาตองการ ) รายละเอียดสามารถดาวนโหลด 
Reference Manual และ Datasheet ไดจากเว็บไซท www.st.com  

 ที่ผมชอบรองลงมาคือใน Firmware Library ของ STM8 มีตัวอยางการใชงาน Peripherals แตละอยางคอนขางละเอียด 
อยางเชน ในการใชงาน UART สามารถรับสงไดทั้ง Asynchronous และ Synchronous Mode สามารถเชื่อมตอกับ IrDA มีตัวอยางทั้ง
รับและสง สามาถติดตอกับ Smart Card ใน Asynchronous Mode มี LIN รวมทั้งมีโหมด Half duplex แบบ single wire 

communication (ใชขา Tx เพียงขาเดียวรับสงแบบ Half Duplex)  ถายังไมพอใจ ใน Performance Line ยังแถม UART ตัวที่สองให
ใช พรอม CAN bus 

 และที่นาสนใจยิ่งขึ้น คือมี Firmware Library ของ Capacitive Touch-Sensing ใหเลือกใชไดฟรีดวย (ใช TIM3, TIM4 

และ Program size ขนาด 2kByte ในการทํา Touch-Sensing) โดยไมจําเปนตองตออุปกรณภายนอกเลย ตามรูปที่ 2. 
 

 
รูปที ่1. แสดงการเกิดอินเทอรรัพท ซอน อินเทอรรัพท 

 
รูปที ่2. แสดงตัวอยางการใช STM8S103K3 ทําหนาที่เปน Touch-Sensing Slave โดยสแกน Touch pad แลวแสดงผลออก LED, 
สงเสียงออก Beeper แลวสงขอมูลให MCU (Host) ตัวอื่นผาน I2C 
 

ในที่นี้ผมขอเลือกยกตัวอยาง Features ของเบอร STM8S105 มาใหชมกัน 
Core 
■ 16 MHz advanced STM8 core with Harvard architecture and 3-stage pipeline 
■ Extended instruction set 
 
Memories 
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■ Medium-density Flash/EEPROM: 
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– Program memory up to 32 Kbytes; data retention 20 years at 55°C after 10 kcycles 
– Data memory up to 1 Kbytes true data EEPROM; endurance 300 kcycles 
■ RAM: up to 2 Kbytes 
 
Clock, reset and supply management 
■ 3.0 to 5.5 V operating voltage 
■ Flexible clock control, 4 master clock sources: 
– Low power crystal resonator oscillator 
– External clock input 
– Internal, user-trimmable 16 MHz RC 
– Internal low power 128 kHz RC 
■ Clock security system with clock monitor 
■ Power management: 
– Low power modes (Wait, Active-halt, Halt) 
– Switch-off peripheral clocks individually 
■ Permanently active, low consumption power-on and power-down reset 
 
Interrupt management 
■ Nested interrupt controller with 32 interrupts 
■ Up to 37 external interrupts on 6 vectors 
 
Timers 
■ 2x 16-bit general purpose timers, with 2+3 CAPCOM channels (IC, OC or PWM) 
■ Advanced control timer: 16-bit, 4 CAPCOM channels, 3 complementary outputs, dead-time insertion and flexible 
synchronization 
■ 8-bit basic timer with 8-bit prescaler 
■ Auto wake-up timer 
■ 2 watchdog timers: Window watchdog and independent watchdog 
 
Communications interfaces 
■ UART with clock output for synchronous operation, Smartcard, IrDA, LIN 
■ SPI interface up to 8 Mbit/s 
■ I2C interface up to 400 kbit/s 
 
Analog-to-digital converter (ADC) 
■ 10-bit, ±1 LSB ADC with up to 10 multiplexed channels, scan mode and analog watchdog I/Os 
■ Up to 38 I/Os on a 48-pin package including 16 high sink outputs 
■ Highly robust I/O design, immune against current injection 
 
Development support 
■ Embedded Single Wire Interface Module (SWIM) for fast on-chip programming and non intrusive debugging 
 

 
รูปที ่3. บล็อกไดอะแกรมภายในของ STM8S 
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 บล็อกไดอะแกรมภายในของ STM8 แสดงตามรูปที่ 3. จะสังเกตุเห็น Voltage regulator ขนาด 1.8V อยูภายในสําหรับเลี้ยง 
MCU core รวมทั้งมี Boot Loader อยูดวย ทําใหสามารถโปรแกรมผาน Serial Communication Port ได โดยไมตองใช 
Programmer/Debugger 

 
รูปที ่4. ไมโครคอนโทรลเลอรในตระกูลน้ีเบื้องตน สามารถแบงออกไดเปนสองไลน คือ Access Line STM8S10x และ 
Performance Line STM8S20x 
 

STM8 ในรุนแรกนี้ จะแบงออกเปนสองไลนตามรูปที่ 4. โดยดานซายมือคือ Common Features ของทั้งสองไลน สวนดาน
ขวามือคือ Features พิเศษของแตละไลน สิ่งที่เหมือนกันคือ ทุกไลนจะมีอยางนอย 1xUART (มี Timer ของตัวเอง), 1xI2C (มี Timer 

ของตัวเอง), 1xSPI (มี Timer ของตัวเอง), 2 หรือ 3ch 16bit General Purpose Timer(TIM1, TIM2, TIM3), 1ch 8bit Time 

Base Timer(TIM4), Independent Watch Dog, Window Watch Dog, Auto Wake up Timer, Internal Beeper, 4ch หรือ 
7ch หรือ 10ch หรือ 16ch 10bit ADC (300ksample/sec), High Speed Internal (HSI) RC OSC 16MHz ที่ +/- 2.5%, Low 

Speed Internal (LSI) ที่ความถี่  128kHz และพอรทสําหรับการโปรแกรม/ดีบัก ขนาด 1 เสน (SWIM: Single Wire Interface 

Module(ประกอบดวย Vcc, Data, GND, RST)) 

 ในรุน Access Line สามารถใชความถี่ High Speed External (HSE) OSC ไดสูงสุดถึง 16 MHz จะไดความเร็ว 12MIPs, 

มีหนวยความจําโปรแกรมตั้งแต 4k, 8k, 16k และ 32kByte (เขียนได 10kครั้ง), มีหนวยความจําแรมตั้งแต 1k และ 2kByte, มี 
EEPROM ต้ังแต 640 และ1kByte (เขียนได 300kครั้ง) 
 สวนในรุน Performance Line มี UART ตัวที่สองเพิ่มเติมเขามา รวมทั้งมี CAN 2.0B ให สามารถใชความถี่ High Speed 

External (HSE) OSC ไดสูงสุดถึง 24 MHz จะไดความเร็ว 20MIPs 

 เบอรที่นาสนใจคือ เบอรที่มีขนาดหนวยความจําตั้งแต 16kByte ลงมา ตามรูปที่ 5. เพราะ  
1)  Free Compiler ของ Cosmic ใชไดไมเกิน 16kByte  

2)  เทาที่ทราบมา (STM8S105K4, STM8S105S4, STM8S105C4) ราคาไมถึง 1 USD ที่ 1kpcs. (แตสามารถซื้อปลีกไดที่ ETT 

หรือขอ sample ไดที่ ST Thailand) 
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รูปที่ 5. รายละเอียดของเบอรตางในตระกูล STM8 
 

 
รูปที ่6. ตัวอยาง Features ตางๆของ Access Line 
 

จะขอยกตัวอยางอนุกรม STM8S105 ตามรูปที่ 6. ซึ่งผมเห็นวาเปนอนุกรมที่นาใชที่สุด (รองลงมาคือ อนุกรม STM8S103) 
แสดงถึง จํานวนขา, จํานวน I/Os, จํานวนขา External Interrupt, จํานวนชอง ADC, ขนาดโปรแกรม, ขนาด EEPROM และขนาด 
RAM สามารถเลือกใชไดตามความเหมาะสมของงาน 
 เนื่องจาก MCU ตระกูลน้ีใชสถาปตยกรรมแบบ Harvard ทําใหการมองหนวยความจําเสมือนเปนแผนเดีนวกัน ตามรูปที่ 7. โดย
จะเริ่มจากแอดเดรส 0x0000 ซึ่งเปนสวนของ RAM และเปนบริเวณเดียวกับ Stack, แอดเดรส 0x4000 เปนที่อยูของ EEPROM และ 
Option Byte, แอดเดรส 0x5000 เปนที่อยูของ SFR: Special Function Register, แอดเดรส 0x6000 เปนที่เก็บ Boot ROM 

Monitoring, แอดเดรส 0x8000 เปนที่เก็บ Interrupt Vector และ Program Memory 
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รูปที ่7. ลักษณะการจัดวางหนวยความจํา จะมีลักษณะเรียงเปนผืนเดียวกัน และมี Boot Loader อยูในตัวแลวดวย 
 

 
รูปที ่8. การจัดเรียงขาของ STM8S105C4 (48 Pins, 38 I/Os) 
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รูปที่ 9. การจัดเรียงขาของ STM8S105S4 (44 Pins, 34 I/Os) 
 

 
รูปที ่10. การจัดเรียงขาของ STM8S105K4 (32 Pins, 25 I/Os) 
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ขาของ MCU ในอนุกรม STM8S105 ต้ังแต 48 pin, 44 pin และ 32 pin แสดงตามรูปที่ 8. ถึง 10. 

 สังเกตุวา บางขาที่อยูในเครื่องหมาย [ ] จะเปนขาที่สามารถ remap ได ดวยการเซ็ตคาใน Option Byte, สวนคําวา (HS) 

หมายถึง High Sink สามารถรับกระแสไดสูงถึง 20mA, โดย VDDIO หมายถึงไฟเลี้ยงที่จายใหขา I/Os แยกตางหากจากขา Vcc (เพื่อให 
I/Os สามารถจายกระแสไดมากขึ้น และไมไปโหลดที่ขา Vcc เพียงขาเดียว) เบอรที่มีขาเยอะๆ ก็จะมี VDDIO หลายๆชุด เพื่อแบงกันจาย
กระแส, ขา VCAP มีไวตอกับ Capacitor ขนาด 0.47uF-1.0uF ภายนอก เพราะภายในของ STM8 มี Voltage Regulator ขนาด 1.8V 

อยูขางใน เพื่อเปนไฟเลี้ยง Core MCU โดยขา VCAP คือขาเอาตพุตของ 1.8V Regulator นั้นเอง สวนขา VDDA และขา VSSA เปนแรงดัน
อางอิงสําหรับการแปลง ADC ที่ตองแยกออกมาตางหาก เพื่อเปนการปองกันการกระเพื่อมของไฟเลี้ยงไปกวน ADC, ขา NRST หมายถึง 
รีเซตที่แรงดันต่ํา (วงจร Power-on รีเซตสามารถ ตอ C ขนาด 0.1uF ที่ขา NRST ลงกราวน) 
 

 
รูปที่ 11. ชวงการทํางานตั้งแตแรงดันไฟเลี้ยง 2.95V-5.5V ที่อุณหภูมิ (-40)-(125) องศาเซลเซียส 
 
 สําหรับบางงานที่ตองการใช High Speed Internal OSC และตองการรันที่แรงดัน 3.3V ก็สามารถทํางานไดดังรูปที่ 11. โดย
มีความถี่เบียงเบนเพียงเล็กนอย ตามรูปที่ 12. สวนรูปที่ 13. แสดงความถี่ที่เปลี่ยนไปของ Low Speed Internal RC OSC ซึ่งจะตออยู
กับวงจร Watch Dog, Auto Wake Up Timer และ Beeper 

 
รูปที่ 12. แสดงความถี่ของ High Speed Internal (HSI) ต้ังแตชวงแรงดันไฟเลี้ยง  2.95V-5.5V จะเห็นไดวามีคาคอนขางคงที่ 
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รูปที ่13. แสดงความถี่ของ Low Speed Internal (LSI) ต้ังแตชวงแรงดันไฟเลี้ยง  2.95V-5.5V 
  

 
รูปที ่14. เว็บไซทของบริษัท COSMIC Software ใหเลือกที่แท็ป DOWNLOAD 
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Download Program 
 

สําหรับผูที่สนใจจะลองใชงาน ใหเริ่มจากการดาวนโหลดโปรแกรม Compiler จากบริษัท COSMIC Software ที่ 
www.cosmic-software.com ตามรูปที่ 14. เลือกรูปธงชาติอเมริกาเพื่อเปลี่ยนเปนภาษาอังกฤษ (COSMIC Software เปนบริษัทของ
ฝรั่งเศส) จากนั้นเลือกที่แท็ป DOWNLOAD ดานขวามือ 

จากนั้นใหเลื่อนลงมาจนพบ STMicroelectronics STM8 free tools เลือกที่ DOWNLOAD ตามรูปที่ 15. จะพบหนาจอ
สําหรับรีจีสเตอร ตามรูปที่ 16. ใหใสรายละเอียดตางๆลงไป ไมตองกังวลเพราะขั้นตอนนี้ไมเสียเงิน จากนั้นจะสามารถดาวนโหลด
โปรแกรมสําหรับติดต้ังช่ือ cxstm8_16k ใหทําการติดต้ัง ตามรูปที่ 17. เสร็จแลวจะไดไอคอนตามรูปที่ 18. ใหดับเบิลคลิกที่ไอดอนเพื่อ
เขาสูโปรแกรม COSMIC compiler editor ตามรูปที่ 19. แลวใหเลือกที่เมนู Help > About Idea… จะไดรูปที่ 20. ใหกดที่ปุม 
License Info. จะปรากฏขอมูลสําหรับแตละเครื่องตามรูปที่ 21. ให copy ขอมลู Product Information ในกรอบลางที่ถูก Highlight 
ไว นํามาวางบน Notepad ตามรูปที่ 22. ซึ่งขอมูลตามตัวอยาง ประกอบดวย Product information ที่ copy มาจาก Cosmic 

Compiler, สวน User information ใหระบุขอมูลของเราลงไป จากนั้นให save แลวสงไปที่ sales@cosmic.fr ใหรอการตอบกลับซึ่ง
ใชเวลาประมาณ 2 วัน 
  

 
รูปที ่15. เลื่อนลงมาจนพบ STMicroelectronics STM8 free tools เลือกที่ DOWNLOAD 
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เมื่อทางบริษัท COSMIC ตอบกลับมา พรอมไฟลแนบ license.lic   ให copy ไปไวที่ C:\Program 

Files\COSMIC\CXSTM8_16k\License\  ตามรูปที่ 23. เพียงเทานี้ เราก็จะสามารถใช COSMIC Compiler ไดฟรีถึง 16kByte 
 

 
รูปที ่16. หนาตางให Register (CITY=Bangkok, Country=Thailand) ที่มีเครื่องหมายดอกจันใหใสขอมูลลงไป  
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รูปที ่17. ใหลงโปรแกรม cxstm8_16k ที่ดาวนโหลดมาได 
 

 
รูปที ่18. ใหดับเบิ้ลคลิกที่ไอคอน Cosmic CxSTM8 16K4.2.7 
 

 
รูปที ่19. เลือกที่เมนู Help > About Idea… 
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รูปที ่20. เลือกที่ปุม License Info. 
 
 

 
รูปที ่21. ให copy ขอมูล Product Information ในกรอบลางที่ถูก Highlight 
 

 
รูปที่ 22. ใชโปรแกรม Notepad สรางขอมูลตามตัวอยาง ประกอบดวย Product information ที่ copy มาจาก Cosmic Compiler, 

สวน User information ใหระบุขอมูลของเราลงไป จากนั้นให save แลวสงไปที่ sales@cosmic.fr ใหรอการตอบกลับซึ่งใชเวลา
ประมาณ 2 วัน 
 
 

 13

mailto:sales@cosmic.fr


 
รูปที ่23. เมื่อไดรับไฟล license.lic มาแลว ให copy ไปไวที่ C:\Program Files\COSMIC\CXSTM8_16k\License\  เพียงเทานี้ 
เราก็จะสามารถใช COSMIC Compiler ไดฟรีถึง 16kByte 
 

 
รูปที ่24. เว็บไซทของบริษัท STMicroelectronics ใหเลือกที่แท็ป Products > Microcontroller 
 

แตเราจะไมไดใช Editor ของ COSMIC เราเพียงแตตองการใช เฉพาะสวน Compiler เทานั้น 

 14



ตอมาคือการดาวนโหลดโปรแกรม Editor และ Programmer/Debugger จากทาง ST, ใหเขาไปที่ว็บไซท www.st.com ตาม
รูปที่ 24. ใหเลือกที่แท็ป Products > Microcontroller จะไดหนาตางตามรูปที่ 25. ในหัวขอ 8-bit Microcontrollers ใหเลือกที่ 
STM8S จะไดรูปที ่26. ใหเลือกที่ Documents and Files for STM8S family ก็จะไดรูปที่ 27. 

 ใหทําการโหลด Datasheet ของ MCU เบอรตางๆ ตามรูปที่ 28.  

 เลื่อนลงมาที่กรอบ Firmware ตามรูปที่ 29. แลวดาวนโหลด STM8S FWLib: STM8S firmware library ซึ่งเปนไลบรารี่
สําหรับ Peripherals ที่ ST เตรียมไวให  และดาวนโหลด STM8S FWLib: STM8S Touch Sensing Library ซึ่งเปนไลบรารี่
สําหรับความสามารถ Capacitive Touch-Sensing ที่ ST เตรียมไวให 
 ใหเลื่อนลงมาที่กรอบ Reference Manual ตามรูปที่ 30. แลวดาวนโหลด RM0016: STM8S microcontroller family 

 สุดทายใหเลื่อนลงมาที่กรอบ Software for Tools ตามรูปที่ 31. แลวดาวนโหลด ST toolset จากนั้นใหเลื่อนลงมาที่กรอบ 

Software Patches แลวดาวนโหลด STVD-4.1.1 Patch 
 

 
รูปที ่25. ในหัวขอ 8-bit Microcontrollers ใหเลือกที่ STM8S 
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รูปที ่26. ใหเลือกที่ Documents and Files for STM8S family 
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รูปที ่27. หนาตางของ Documents and Files for family STM8 - 8- bit Microcontrollers 
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รูปที ่28. ใหเลื่อนลงมาที่กรอบ Datasheet แลวดาวนโหลด STM8S103, STM8S105, STM8S903 และ STM8S208 
 

 
รูปที ่29. ใหเลื่อนลงมาที่กรอบ Firmware แลวดาวนโหลด STM8S FWLib: STM8S firmware library ซึ่งเปนไลบรารี่สําหรับ 
Peripherals ที่ ST เตรียมไวให  และดาวนโหลด STM8S FWLib: STM8S Touch Sensing Library ซึง่เปนไลบรารี่สําหรับ
ความสามารถ Capacitive Touch-Sensing ที่ ST เตรียมไวให 

 18
 



 
รูปที ่30. ใหเลื่อนลงมาที่กรอบ Reference Manual แลวดาวนโหลด RM0016: STM8S microcontroller family 
 

 
รูปที ่31. ใหเลื่อนลงมาที่กรอบ Software for Tools แลวดาวนโหลด ST toolset จากนั้นใหเลื่อนลงมาที่กรอบ Software Patches 

แลวดาวนโหลด STVD-4.1.1 Patch 
 
 ใหทําการลงโปรแกรม sttoolset ซึ่งจะไดไอคอน ST Visual Develop (STVD) และ ST Visual Programmer (STVP) 

ตามรูปที่ 48. จากนั้นใหลงโปรแกรม stvd-4.1.1patch1  เมื่อลงโปรแกรม STVD เสร็จ โปรแกรม STVD จะเขาไปคนหา COSMIC 

Compiler มาเก็บไวใชงานเอง 
 ตอมาใหลง example ของ Peripherals และ Template project โดยการระเบิดไฟล stm8sfwlib_v1_1_0.zip  ออกมาแลว 
move ไปไวที่ C:\Program Files\STMicroelectronics\ 
 
ST-Link 
 
 สําหรับ Tools ในการพัฒนา เราจะใช ST-Link สําหรับเปน Programmer/Debugger ตามรูปที่ 32 (หาซื้อไดที่ ETT) โดย
การเชื่อมตอกับ PC ผานทาง USB พอรต (ST-Link สามารถใชไดทั้ง MCU 8 bit (SWIM) และ 32 bit (JTAG) ของทาง ST) 
รายละเอียดอานไดที่  C:\Program Files\STMicroelectronics\st_toolset\stvd\ST-LINK.pdf 

 ในชุดของ ST-Link จะประกอบดวยอุปกรณตามรูปที่ 33. การตอใชงาน ST-Link แสดงตามรูปที่ 34.ถึง 38. 
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รูปที ่32. หนาตาของเครื่อง Programmer/Debugger ของแทจาก ST ไดขาววาสามารถหาซื้อไดที่ ETT ราคาประมาณ 1,000 บาท 
 

 
รูปที ่33. อุปกรณในชุด ST-Link จากซายไปขวา ประกอบดวย สายเสียบแยกสําหรับ STM8 SWIM (สามารถเสียบเขา Male IDE 

Connector ได), สายแพรเสียบ 4 เสน สําหรับ STM8 SWIM (แตคอนเนคเตอรเปนแบบเล็กพิเศษ), สายแพร 20 เสนสําหรับ JTAG 

(ARM 32bit MCU), ตัวบอดี้ของ ST-Link พรอมสาย USB 
 

 20



 
รูปที ่34. แสดงการตอสายแพรแบบ 4 เสน เขากับ ST-Link 
 

 
รูปที ่35. แสดงการตอสาย SWIM แบบ 4 เสน เขาที่พอรทของ STM8 Evaluation Board 
 

 
รูปที ่36. แสดงการตอสายแยกแบบ 7 เสน เขากับ ST-Link 
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รูปที ่37. แสดงการตอสายแยกแบบ 7 เสน ระหวาง ST-Link กับบอรดที่พัฒนา, สังเกตุวาใชเพียง 4 เสน คือ VCC, Data, GND, NRST 

ในขณะที่ขา UART-RX, UART-TX, BOOT0 สงวนไวใชในอนาคต 
 

 
รูปที ่38. แสดงการตอ ST-Link เขากับบอรดที่พัฒนา กรณีที่ใชกับ ARM 32bit MCU (STM32) 
 
STM8 Firmware Library  
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ตอมาเราจะลองลง Firmware Library ของ STM8 ตามรูปที่ 39. โดยภายในโฟลเดอร STM8SFW_v1_1_0\FWLib จะ
ประกอบดวย โฟลเดอร examples จะเก็บตัวอยางการใช Peripherals ทั้งหมดของ STM8 ในขณะที่โฟลเดอร library และโฟลเดอร 
project เปน” Template Project” สําหรับ copy ไปใชงานตามรูปที่ 40. 
 

 
รูปที ่39. แสดงการลง Firmware Library ของ STM8 (ตัวอยางการใชงาน Peripherals และ Template Folder ) เมื่อ unzip ไฟล 
stm8sfwlib.zip ออกมาจะได โฟลเดอร C:\Program Files\STMicroelectronics\STM8SFW_v1_1_0\ ตามรูป 
 

 
รูปที ่40. ภายใน FWLib จะประกอบดวย 3 โฟลเดอร โดย examples จะเก็บตัวอยางการใช Peripheral ทั้งหมดของ STM8 ในขณะที่ 
library และ project เปน”โปรเจคเปลา” สําหรับ copy ไปใชงานไดเลย (Template Project) 
 
 ในโฟลเดอร example จะประกอบดวยตัวอยางการใชงาน Peripherals ของ STM8 ทั้งหมด ตามรูปที่ 41. ประกอบดวย 

ADC2 สอนการใชงาน ADC ทั้งในโหมด ตอเนื่อง และโหมดแปลงครั้งเดียว 
AWU  สอนการใชงาน Auto Wake Up Timer 

BEEP  สอนการใชงาน Hardware Beeper เพื่อต้ังความถี่ 1k,2k หรือ 4kHz 

CAN  สอนการใชงาน CAN bus 2.0B 

CLK  สอนการใช Clock gating สําหรับ Peripherals ทุกตัว 
Common  สอนการใชงาน LCD และ SD card 

EXTI  สอนการใชงาน External Interrupt (ทุกพอรตของ STM8 สามารถกําหนดเปนขา External Interrupt ได) 
FLASH  สอนการใชงานเขียน/อาน Flash Memory (IAP: In Application Programming) และ EEPROM 

GPIO  สอนการใชงาน General Purpose I/Os 

I2C  สอนการใชงาน I2C ทั้ง Master และ Slave โหมด 
ITC  สอนการใชงาน Interrupt Controller 

IWDG  สอนการใชงาน Independent Watch Dog 

RST  สอนการใชงาน Reset แบบตางๆ 
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SPI  สอนการใชงาน SPI 

TIM1  สอนการใชงาน Advance Timer 1 สําหรับขับมอเตอร 3 เฟส แบบมี dead time ในตัว 
TIM2  สอนการใชงาน General Purpose Timer 2 และ 3 ขนาด 16 bit 

TIM4  สอนการใชงาน General Purpose Timer 4 ขนาด 8 bit พรอม prescaler ขนาด 8 bit 

TIM5  สอนการใชงาน General Purpose Timer 5 ขนาด 8 bit มีในบางเบอร 
UART1  สอนการใชงาน UART ทั้ง Asynchronous, Synchronous, Single wire Half-Duplex, Smart card, IrDA 

WWDG  สอนการใชงาน Window Watch Dog 
 

 
รูปที ่41. แสดงตัวอยาง Peripherals ตางๆ ในโฟลเดอร examples 
 

 
รูปที ่42. แสดงตัวอยางยอยของ Peripheral UART1 ซึ่งประกอบดวย 9 การทดลอง 
 
 ในแตละโฟลเดอรของ Peripherals ก็จะมีตัวอยางยอยใหศึกษาอีกมากมาย ยกตัวอยางเชน ตัวอยางยอยของการใชงาน UART1 

ตามรูปที่ 42. จะพบวามีถึง 9 การทดลอง ทั้ง IrDA, SmartCard, Synchronous และ Single wire Half Duplex 
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 การสรางโปรเจคของ ST จะแตกตางจาก MCU เจาอื่นๆที่มักจะมี Wizard ไวคอยชวยสรางโปรเจค แตของ ST จะใชลักษณะ
เปน Template Project กลาวคือเปน”โปรเจควาง” ที่ Link แตละสวนไวใหอยูแลว เราเพียงแค copy เอาไปใชงานไดเลย ขอใหศึกษาจาก
ตัวอยางตอไปนี้ สมมุติวาเราตองศึกษาการใชงาน ADC2 แบบ Continuous Conversion (ซึ่งเปนตัวอยางอยูใน 
FWLib\examples\ADC2\ADC2_ContinuousConversion\) ใหเราทําการ copy โฟลเดอร library และโฟลเดอร project ที่อยูใน 
FWLib\ ตามรูปที่ 43. ไปใสไวในโฟลเดอร  FWLib\examples\ADC2\ADC2_ContinuousConversion\ ตามรูปที่ 44. 
 

 
รูปที ่43. การนํา Template project ไปใชงาน ให copy โฟลเดอร library และโฟลเดอร project ไปพรอมกันทั้งคู 
 

 
รูปที ่44. จากนั้นมาวางไวในบริเวณที่จะใชงาน ตามรูปจะลองใชงานตัวอยาง ADC2_ContinuousConversion 
 

 
รูปที ่45. ให copy ไฟล main.c, main.h และ stm8s_conf.h ไปทับใน sub  project ตามรูป 
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 จากนั้นให copy ไฟล main.c, main.h และ stm8s_conf.h ใน 
FWLib\examples\ADC2\ADC2_ContinuousConversion\  ตามรูปที่ 45. ไปทับไฟลใน โฟลเดอร 
FWLib\examples\ADC2\ADC2_ContinuousConversion\project\  ตามรูปที่ 46. จากนั้นให copy ไฟลที่เหลือใน 
FWLib\examples\ADC2\ADC2_ContinuousConversion\  ซึ่งประกอบดวย readme.txt, stm8_interrupt_vector.c, 

stm8s_it.c และ stm8s_it.h  ตามรูปที่ 47. ไปทับไฟลใน โฟลเดอร 
FWLib\examples\ADC2\ADC2_ContinuousConversion\project\STVD\COSMIC\  ตามรูปที่ 48. 
 

 
รูปที ่46. ให paste ไฟลทั้ง 3 ทับไฟลเกา ตามรูป 
 

 
รูปที ่47. จากนั้นให copy ไฟลที่เหลือ ประกอบดวย readme.txt, stm8_interrupt_vector.c, stm8s_it.c และ stm8s_it.h 
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รูปที ่48. ไปทับไวใน sub  project\STVD\Cosmic ตามรูป 
 

 
รูปที ่49.แสดงโปรแกรม ST Visual Develop สําหรับเปนศูนยกลางการพัฒนา STM8 (เปน Editor, เปน Programmer/Debugger) 
 

 
รูปที ่50. เมื่อดับเบิลคลิกที่ไอคอน ST Visual Develop จะไดหนาจอสําหรับพัฒนาดังนี้ ใหเลือกเมนู File > Open Workspace… 
 
ST Visual Develop (STVD) 
 
 ตอมาใหดับเบิลคลิกที่ไอคอน ST Visual Develop (STVD) ตามรูปที่ 49. จะไดหนาตางโปรแกรมตามรูปที่ 50. ไปที่เมนู 
File > Open Workspace… แลวเลือกไฟล  project.stw ในโฟลเดอรตามรูปที่ 51. จะปรากฎ workspace ซึ่งประกอบดวยหลายๆ 
project ซอนกันอยูใน workspace เดียวกัน ตามรูปที่ 52. (ST จะทําการแยก MCU แตละเบอรเปนโปรเจคตางๆ แยกกัน ถาตองการใช 
MCU เบอรไหน ใหคลิกขวาที่โปรเจคของ MCU เบอรนั้น แลวเลือก Set As Active Project สังเกตุวาโปรเจคนั้นจะกลายมาเปนอักษร
ตัวหนา) ใหเปดไฟล readme.txt ขึ้นมา ตามรูปที่ 52. ในไฟล readme.txt จะบอกเราวา การทดลองนี้ตองการสอนอะไรเรา ตอง Add 

ไฟล *.c ใน library ตัวไหนบางเขามาในการทดลองนี้ ยกตัวอยางเชน readme.txt ของการทดลองนี้บอกเราวา 
 
   @par How to use it ? 
 
   In order to make the program work, you must do the following : 
   - Create a project and setup all project configuration 
   - Add the required Library files : 
      - stm8s_adc2.c 
      - stm8s_gpio.c 
   - Edit stm8s.h file to select the device you are working on (#define STM8S208, in this case). 
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 นั้นคือใหเราทําการเพิ่มไฟล stm8s_adc2.c และไฟล stm8s_gpio.c ซึ่งอยูในโฟลเดอร 
FWLib\examples\ADC2\ADC2_ContinuousConversion\library\src\  เขามารวมไวในโปรเจคนี้ดวย วิธีการคือใหเลื่อนเมาสไปที่
กรอบซายมือของรูปที่ 52. คลิกขวาที่โฟลเดอร Library ภายใตโปรเจคที่ตองการ (ในรูปที่ 52. คือ stm8s208) จากนั้นเลือก Add Files 

To Folder… แลวถอยออกจากโฟลเดอรปจจุบัน 3 ระดับ แลวเขาไปที่โฟลเดอร  library\src\  กดปุม Ctrl คางไว เลือก stm8s_adc2.c 
และ stm8s_gpio.c จากนั้นกดปุม Open (ในตัวอยาง Peripherals ของ ST ทั้งหมดจะเลือก stm8s208 เปน Default เพราะเปนตัวที่
ใหญสุดในตระกูลน้ี ถาเราตองการใชเบอรอื่น เชนเบอร stm8s105 ใหเลือก stm8s105 เปน default project และตอง uncomment 

directive   #define STM8S105 ในไฟล stm8s.h ดวย) 
 

 
รูปที ่51. ลองเขาไปในตัวอยาง ADC2_ContinuousConversion ตามโฟลเดอรในภาพ จากนั้นเลือกไฟล project.stw 
 

 
รูปที ่52. ใน Firmware Library ของ ST version 1.1.0 จะเตรียม MCU เบอรตางๆใหเลือกเปนโปรเจควาง ตามกรอบซายมือในรูป 
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รูปที ่53. ประกอบดวยปุม Compile, ปุม Build และปุม Rebuild All จากซายไปขวา (ปรกติมักจะใชปุม Rebuild All) 
 
 จากนั้นใหกดปุม Rebuild All ตามรูปที่ 53. เพื่อ compile และ Link สรางไฟล.s19 เพื่อจะนําไปโปรแกรมลง MCU ตอไป ถา
ทําทุกอยางถูกตอง ในกรอบลางของหนาตางจะบอกวา 
 0 error (s) , 0 warning (s) 
 ตามรูปที่ 54. (ถึงแมจะมี warning บางก็ไมเปนความผิดปรกติใดๆ สามารถใชงานได) 
 

 
รูปที ่54. ถาทุกอยางถูกตอง ในกรอบดานลางจะไมแจง error หรือ warning ใดๆ ตามรูป 
 

 
รูปที ่55. ใหเลือกเครื่องมือสําหรับการโปรแกรม/ดีบัก จากเมนู Debug instrument > Target Setting… ในชอง Debug Instrument 

Selection: ใหเลือก Swim ST-Link ตามรูป 
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 จากนั้นใหไปที่เมน ูDebug instrument > Target Setting… ในชอง Debug Instrument Selection: ใหเลือก Swim ST-

Link ตามรูปที่ 55. เพื่อเลือก ST-Link เปนเครื่องมือสําหรับ Program/Debug เมื่อตองการดีบักใหกดปุมสีฟา ซายมือสุดของรูปที่ 56. 

STVD จะทําการติดตอกับ ST-Link แลวโปรแกรมบริเวณ Flash memory พรอมกับการเขาโหมดดีบัก (รายละเอียดเพิ่มเติมจะขอ
กลาวถึงในบทความตอๆไป) 
 ถาโปรแกรมไมได อาจจะเกิดจาก STVD ติดตอกับ ST-Link ไมได หรือบอรที่เราพัฒนาขึ้นมายังไมไดจายไฟเลี้ยง 
 

 
รูปที ่56. เมื่อตองการโปรแกรม Flash memory พรอมกับดีบัก ใหกดปุมสีน้ําเงิน ซายมือสุดตามรูป (ปุมที่เหลือใชสําหรับการดีบัก) 
 
ST Visual Programmer (STVP) 

 
ตอมาเปนการใชงานโปรแกรม STVP สําหรับ Burn Flash memory, EEPROM data และ Option Byte ใหดับเบิลคลิกที่

ไอคอนตามรูปที่ 57. จะไดหนาตางตามรูปที่ 60. ใหกดปุมดานซายของเบอร MCU ตามรูปที่ 58. เพื่อเลือกเครื่องมือพัฒนา และเบอรของ 
MCU ที่จะใช (ในที่นี้สมมุติวาจะใช ST-Link และ MCU เบอร STM8S105K4T6) จากนั้นเลือกตามรูปที่ 59. กด OK 
 

 
รูปที ่57. แสดงโปรแกรม ST Visual Programmer สําหรับ Program STM8 MCU ผาน ST-Link โดยไมตองดีบัก 
  

 
รูปที ่58. กดปุมดานซายของเบอร MCU ตามรูป เพื่อเลือกเครื่องมือพัฒนา และเบอรของ MCU ที่จะใช 
 

 
รูปที ่59. ในกรอบ Hardware ใหเลือก ST-LINK สวนในกรอบ Device: ใหเลือกเบอร STM8 ที่ตองการพัฒนา 
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รูปที ่60. แท็ปแรกของ PROGRAM MEMORY ซึ่งไฟลที่จะดาวนโหลดจะอยูในรูปของ  *.s19 เริ่มตนที่แอดเดรส 0x8000 

 

 
รูปที ่61. แท็ปที่สองของ DATA MEMORY (EEPROM AREA) ซึ่งไฟลที่จะดาวนโหลดจะอยูในรูปของ  *.s19 เชนกัน แตเริ่มตนที่
แอดเดรส 0x4000 
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รูปที ่62.แท็ปที่สามของ OPTION BYTE  ซึ่งใชเซ็ตการปองกันการเขียน, ปองกันการอาน, ปองกันการเขียนเปนสวนยอยๆ, ใชรีแมพขา
สําหรับ ขาทางเลือกตางๆ, ใชกําหนดการอนุญาติ watch dog, ใชปรับละเอียด HSI และอณุญาติการใชฟงกช่ัน Boot Loader (พอ
เทียบเคียงไดกับการเซ็ต configuration bits ของ Microchip) 
 

ในหนาจอของ STVP จะแบงออกเปน 3 แท็ป ประกอบดวย Program memory Tap, Data memory Tap และ Option 

Byte Tap ตามรูปที่ 60. ถึง 62. โดยสามารถโหลดโปรแกรมแยกสวนกันมาลงก็ได หรือทําการโหลดทั้ง 3 แท็ปเขามาพรอมกันทีเดียว 
โดยการสรางไฟลทั้ง 3 ในรูปของ program project ( *.stp ) ซึ่งขั้นตอนนี้ตองเซ็ตบน STVD ขั้นตอนสุดทายคือการ อานและเขียนลง 
MCU ผาน ST-Link ซึ่งรายละเอียดแสดงในรูปที่ 63. (รายละเอียดของ Option Byte ในแตละเบอรจะแตกตางกันไป ขอใหอานใน 
Datasheet แตพอสรุปกวางๆไดวา ประกอบดวย ROP: Read Out Protect, UBC: User Block Code ใชปองกันการเขียน Flash 

เปนบล็อกยอยๆ, AFR: Alternative Function Register ใชในการ Remap ขา MCU, สวน Trim HSI OSC, สวนเกี่ยวกับ 
Watchdog, สวนเกี่ยวกับการใช HSE OSC และสวนการอนุญาติใหใช Boot Loader) 
 

 
รูปที ่63. ปุมที่ใชในการ อาน/เขียน แบงเปน 3 กลุม ที่ใชบอยคือกลุมซายมือ ใชในการ อาน/เขียน เฉพาะแท็ปที่เลือก สีเขียวปุมแรกใชใน
การอาน สีแดงปุมที่สองใชในการเขียน สวนกลุมขวามือสุด ใชในการ อาน/เขียน ทุกแท็ปที่ เชนกันสีเขียวปุมแรกใชในการอาน สีแดงปุมที่
สองใชในการเขียน 
 
 จะเห็นไดวา MCU ตัวใหมนี้ มีความนาสนใจ ทั้งประสิทธิภาพที่สูง (กวา 20MIPs at 24MHz), Peripherals ตางๆที่ครบครัน 
และราคาที่แสนจะประหยัด รวมทั้งสามารถประยุกตทําปุมกดแบบสัมผัสไดในตัว ทําให Product ดูมีราคาและประหยัดเงินคาปุมกดไปไม
นอย เมื่อมีบอรดพัฒนารุนใหมจาก ETT ออกมา รวมกับ Programmer/Debugger รุน ST-Link คงจะทําให MCU ตระกูลน้ี เปนที่นิยม
ในตลาด 8 bit ไดไมยาก 
 ในโอกาศตอไป ผมขอจะกลาวถึง ตัวอยางการใชงาน Peripherals ที่สําคัญแตละอยาง รวมทั้งวิธีการลงโปรแกรมและการใช
งาน Capacitive Touch-Sensing Firmware Library ขั้นตอนการออกแบบลายวงจรสําหรับ Touch-Sensing (TS) วิธีการปรับแตง
พารามิเตอรของ TS รวมทั้งการเขาโหมดดีบีก เพื่อทําการ tuning แบบ real time 

พงษศักดิ์  พรอมวงศ (  ) 
เทียนไชย  นกครุฑ  ( tienchai.n@gmail.com ) 
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